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' (apostrophe), 52, 83
! (bang character), 81, 155, 359
: (colon), 290
:= (colon equal sign), 45
, (comma), 38, 42, 43
_ (continuation character), 156-158
. (dot), 79, 81, 359
= (equal sign), 80
! (exclamation point), 138
* (multiplication operator), 106
() (parentheses)
checking, 275-276
for ending procedure, 37, 42, 353
| (pipe), 63
+ (plus sign), 44, 106, 157
# (pound character), 83
? (question mark), 79
" (quotation marks), 58, 83, 353
[] (square brackets)
in Access, 91
as representing argument, 40, 41
as representing name, 154-155
typing, 353

o/ ] o

Access 2003 All-in-One Desk Reference
For Dummies (Alan Simpson,
Margaret Levine Young, Alison
Barrows), 9

Access 2003 For Dummies
(John Kaufeld), 9

Access (Microsoft)

class module, 12-15
client-server relationship and, 297-303

database window, 10
description of, 1
11.0 Object Library, 31
Help system, 354
learning before using VBA, 351
Modules container, 10
Query menu, 122
references for learning about, 9
standard module, 12-13
switching between Visual Basic editor
and, 15-16
accessing object library, 317-319
Action Arguments, 311-312, 315
action query
hiding warning message, 125-126
on one record, 136
overview of, 121-123
Add Procedure dialog box, 36, 37
address, correcting case of with
PCase() function, 248-252
ADO (ActiveX Data Objects), 141
AdOpenDynamic cursor type, 145
After Focus event, 89
After Insert Event form event, 98
After Update event, 220
All tab (Properties sheet), 185, 203
AlT1Forms collection, 149
Al1TabTes collection, 209
Alt+F11 (switch between Access and
Visual Basic editor), 16, 354
Alt+Q (close Visual Basic editor), 15
AND operator, 67
apostrophe (), 52, 83
appearance of object, changing
color, 99-103
font or style of text, 103
special effects, 103-104
With...End With statement, 104-105
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append query, 122, 131-132
appending record to table
overview of, 131-132
with query, 133-134
single, with SQL, 132-133
application modal, 178
Application object
description of, 319-320
Outlook, 326
argument
CursorType (recordset), 142-143, 145
definition of, 40
function and, 244-245
Help page and, 43-45
keyword support for, 41
LockType (recordset), 143
MsgBox () keyword, 43-45, 177-179
named, 45
OpenForm method of DoCmd object,
107-108
order of, 45
parameters and, 161
square brackets ([]) and, 40, 41
Sub procedure, 56
syntax for, 55
title, 44
value for, 42
argument list, 55
array, storing data in, 58-60
ASCII number, 191
asking question of user, 362-363
Automation technology, 28, 317

o5 e

BackColor property, 100

back-end database table, 298, 299, 300

backing up data, 135

BackStyle property, 101

bang character (1), 81, 155, 359

Barrows, Alison, Access 2003 All-in-One
Desk Reference For Dummies, 9

Beep method of DoCmd object, 81-82

Before Update event, 89
binding dialog box to table, 184
blank space, inserting in code, 157
BOF property, 145
book, Web site for, 5
bookmark, 326, 327
Boolean data type, 53, 62
BorderColor property, 100
BorderStyTe property, 101
Bound Column property, 230, 232-233
bound control, adding to form, 187
breaking long line of code, 156-158
breakpoint
clearing, 284-285
setting in code, 280-284
bug, definition of, 267
Build button (Design view), 241, 242
Building a List of Report Names
listing, 194
button
default, for message box, 178-179
On Click event and, 87
buttons argument of MsgBox ()
keyword, 43-44, 177-179
Byte data type, 53, 62

oo

calling procedure
from event, 170-172
overview of, 18

changing. See also appearance of object,

changing

contents of control, 360

control type, 204

table record, 134-136

value of property, 80
checking

parentheses, 275-276

whether form is open, 358
class, definition of, 14, 31, 76
Class icon, 78



06e_574116_bindex.gxd 7/27/04 10:31 PM

Page 373 $

Index 3 73

class module (Access)
description of, 12-13, 87
finding, 13-15
Me term, 155
Project Explorer and, 24
Classes list (Object Browser), 31
clearing breakpoint, 284-285
client, definition of, 297
Close method of DoCmd object, 109
closing
form, 109
Object Browser, 33
recordset, 146
table through VBA, 130-131
Visual Basic editor, 15-16
code. See also listings; syntax
automating task and, 12
blank space, inserting in, 157
breaking long line of with continuation
character (), 156-158
in class module, 14
commenting, 52-53
conventions for, 2
converting query to, 129
copying, 355
creating in pieces, 265
definition of, 11
encapsulation of, 218-219, 221
linking to external data through,
305-307
modifying existing, 46-48, 57, 123-125,
153-154
object and event for, choosing, 92-95
PaymentMethod_AfterUpdate()
procedure, 93-95
recordset, creating, 139-140
sample, acquiring, 51
slowing down, 280-284
typing, 27-28
Code window (Visual Basic editor)
Help methods in, 84
overview of, 15, 16, 26-28
shortcut keys, 367-369
viewing existing code in, 153-154

CodeContextObject, 155
collection
Al1Forms, 149
All1Tables, 209
Count property, 79, 147-148
CurrentProject.AlT1Forms, 358
CurrentProject.Al1Reports, 190
enumerating, 147-153
Forms, 72, 73, 79, 149, 358-359
looping through, 147-148
object compared to, 72-74, 148
colon (©), 290
colon equal sign (:=), 45
color
for dialog box, 186
of object, changing, 99-103
Color Builder, 100-101
Column Count property, 232
combo box
creating, 189-190
description of, 188-189, 201-202
drop-down menu, customizing, 195
dynamic drop-down list for, building,
190-194
field names, listing, 204-206
hidden values in, 229-233
linking lists, 217-219
linking lists across forms, 223-229
properties, 203
as quick find tool, 233-236
self-referential, creating, 237-239
table/query field values, listing, 213-217
text options, listing, 207-213
unbound control, adding to, 202-203
updating, 224-226, 361
updating from table, 222
updating report names in, 221-222
Combo Box Wizard, 231-232, 234-235, 238
comma (,), 38, 42, 43
Command Button Wizard, 288-289
commenting code, 52-53
comparison operators, 66-67
compilation or compile time, 269
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compile error
cause of, 269
description of, 270, 271-273
Expected: end of statement
message, 274
Expected: expression message,
273-274
Expected: list separator or )
message, 274-275
message example, 28, 272
understanding message, 271
compiling line of code, 28
concatenating strings, 157
condition, description of, 63
conditional expression, 6667
connection
closing, 146
defining, 140-141
to external program, 321-322
constant
buttons argument of MsgBox ()
keyword, 178-179
color, 100
definition of, 38, 43
list of, 39
storing data in, 58
Constant icon, 78
continuation character (), 156-158
control. See also combo box; list box
adding to dialog box, 186-188
bound, adding to form, 187
changing contents of, 360
changing type of, 204
description of, 73
enabling or disabling, 90-91
event and, 89
filling with data, 105-107
locking and unlocking, 96
moving cursor to, 359-360
naming, 203
on open form, referring to, 359
requerying with every new record,
238-239

showing or hiding, 95-96
spin box, creating, 195-198
unbound, adding to form, 187, 202-203
updating on separate form, 228-229
Visible property, 79-80
Control Wizards
adding control to dialog box and, 187
Combo Box Wizard, 231-232,
234-235, 238
error-handling code and, 288-289
Control Wizards button
Design view, 17
Toolbox, 231
converting
linked table to local table, 300
macro to VBA code, 313, 314
query to code, 129
CopyFromRecordset method (Excel), 344
copying
code from Web, 46-47, 355
data before querying, 135
data before testing, 251
SQL statement into VBA code, 123-125
table or query results to Excel
worksheet, 344-347
CopyQbject action, 314
Count property of collection, 79, 147-148
CREATE TABLE statement (SQL), 129-130
Ctrl+C (Copy), 46
Ctrl+F8 (Run to Cursor), 283
Ctrl+Shift+F8 (Step Out), 283, 284
Ctrl+V (Paste), 46
Currency data type, 53, 62
CurrentProject.Al1Forms
collection, 358
CurrentProject.AlTReports
collection, 190
cursor
moving to control, 359-360
positioning, 38, 91-92
CursorType argument (recordset),
142-143, 145
Customer Lookup query, 230-231, 234
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DAO (Data Access Objects), 142
data
backing up, 135
copying before testing, 251
form control, filling with, 105-107
importing from external database,
303-305
linking to external through code,
305-307
passing to function, 244-245
passing to procedure, 55-57, 164
recordset, filling with, 142-143
storing in combo box, 232-233
Data Access Objects (DAO), 142
Data tab (Properties sheet), 189
data types, 53-55, 62
database. See also recordset; SQL
(Structured Query language); table
back-end and front-end, 298, 299, 300
importing data from external, 303-305
objects and, 85
splitting into two files, 297
Database Splitter, 297-303
DataMode argument of OpenForm
method of DoCmd object, 108
Datasheet view of query, 138
Date data type, 53
Date() function, 56
date, literal, 83
Date/Time data type, 62
Debug toolbar, 284
debug window (Visual Basic editor),
25-26
Debugr>Clear All Breakpoints, 284
debugging
compile errors, 271-276
definition of, 267
logical errors, 276-285
shortcut keys for, 370
Debug.Print statement
checking variable with, 277-280
seeing name of object with, 150

Debugr>Step Into, 283
Debugr>Toggle Breakpoint, 281
Decimal data type, 54
decision-making
comparison operators, 66-67
If...End statement, 67-68
procedure and, 128
Select Case block, 68-69
declarations area of module, 60-61
declaring
array, 59
object variable, 152, 321
variable, 165
Default Method icon, 78
Default Property icon, 77
Default Value property (combo box
and list box), 203
Delete Event form event, 98
Delete query, 122, 134-137
deleting
table record, 134-136
table through VBA, 130-131
delimiting literal text and dates, 83
dependency, 218
Design view
Build button, 241, 242
combo box sample in, 190
Control Wizards button, 17
Detail band, 186
dialog box sample in, 187
form events in, 96-97
designing message box, 177-180
Detail band (Design view), 186
Details pane (Object Browser), 31
detecting right-click, 198-199
dialog box
controls, adding, 186-188
converting form to, 182-183
form properties, setting, 184-186
overview of, 175
storing settings, 183-184
Dim statement, 152
disabling form control, 90-91
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displaying
control, 95-96
custom message, 361-362
Immediate window, 25
properties, 75-76
toolbar, 21
docking Code window, 27
DoCmd (do command) object
Beep method, 81-82
Close method, 109
description of, 32
methods for forms, 111-113, 364-365
OpenForm method, 82, 107-108,
357-358
TransferDatabase method, 304-307
DoCmd.RunSQL statement, 124, 125, 146
Do...Loop block, 62-63
dot (), 79, 81, 359
DOT file, 327
Double data type, 54, 62
drop-down menu
customizing, 195
dynamic, building, 190-194
static versus dynamic, 190

oF o

element of array, 58
e-mail, sending via Outlook, 322-326
enabling form control, 90-91
encapsulation, 218-219, 221
Enter key and typing code, 27-28
Enum icon, 78
enumerating collection
For Each loops, 149-151
object, using shorter name for, 152-153
overview of, 147-148
EOF property, 145
equal sign (=), 80
error handler
creating, 287-290
writing, 290-294

errors
compile, 271-276
logical, 276-285
runtime, 285-294
types of, 270-271
event
After Focus, 89
After Insert Event form event, 98
After Update, 220
Before Update, 89
calling procedure from, 170-172
for code, choosing, 92-95
Delete Event form event, 98
form, responding to, 96-99
Load Event form event, 98
On Change, 89
On Click, 87, 89, 188, 198-199
On Close form event, 98
On Current form event, 98
On Insert, 226
On Load, 190, 208, 219
On Mouse Down, 89, 198
Event icon, 78
Events tab (Properties sheet), 88, 96
Excel (Microsoft)
code to copy form data to worksheet,
338-347
interacting with, 336
macro, running from Access, 347-348
query and form, creating, 337-338
worksheet, creating, 336-337
exclamation point (1), 138
execute, definition of, 12
existing code, modifying
argument list and, 57
copying and pasting from Web, 46-47
For Each...Next loop and, 153
importing standard module, 47-48
overview of, 46, 48, 153-154
SQL statement into VBA code, 123-125
Expected: end of statement error
message, 274
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Expected: = error message, 271-272
Expected: expression error message,
273-274
Expected: Tist separator or )
message, 274-275
exporting
interactively, 311
with macro, 311-313
exposing object, 28-29
expression
conditional, 66-67
testing in Immediate window, 26, 42-43
Expression Builder, 241

ofF e

F1 (Help), 39, 356
F2 (open Object Browser), 30
F4 (Properties sheet), 74
F8 (Step Into), 283
Fancy SkipLabels Dialog Box
code for, 220
overview of, 217-218
field in recordset, referring to, 145-146
field name
listing in combo box or list box, 204-206
referring to, 154-155
File=>Close, 15
Filec>Export, 311
File>Get External Data>Import, 47
filling
form control with data, 105-107
recordset with data, 142-143, 166-170
FilterName argument of OpenForm
method of DoCmd object, 107
focus, giving control, 91
font, changing, 103
For Each...Next loop, 149-151, 153, 191
ForeColor property, 100, 103
form
adding related record to another table,
109-111
appearance of object, changing, 99-107

class module, opening, 14-15

class procedures, 87-89

closing, 109

control, enabling or disabling, 90-96

converting to dialog box, 182-183

description of, 10, 14, 73

DoCmd object methods for, 111-113

opening, 107-108

opening from VBA, 357-358

properties to turn into dialog box,

184-186

referring to open, 358-359

working with, 87
form event, responding to, 96-99
form names, making list of, 211-213
Form view

combo box sample in, 190

dialog box sample in, 187
Form_Address Book Formlisting, 111
Format function, 260
Format tab (Properties sheet), 99
formatting worksheet cells from VBA,

343, 347-348

Form_Current() procedure, 97-98
Form_Load () procedure, 219
Forms collection

Count property, 79

description of, 149

object model and, 72, 73

referring to open form and, 358-359
For...Next block, 64-65
friction in computer, 268
front-end database, 298, 299, 300
function. See also procedure

arguments and, 244-245

built-in, listing, 242

creating, 243-244

Date(), 56

Format, 260

GetObject(), 341

Mid(), 278, 280

NumWord(), 253-265, 279-280

overview of, 241
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function (continued) high-level programming language, 268-269
passing data to, 244-245 hyperlink field, 231
PCase(), 247-252
Public, 19, 37 ® 1 ®
returning value from, 245
role of, 241-243 icons
SalesTax() example, 244-247 for items in Object Browser, 77-78
StrConv (), 247, 249 for saved action queries, 138
testing, 246-247 identifier
testing from Immediate window, 281 description of, 80
UCase(), 278 square brackets and, 154-155
Function procedure syntax, 81
creating, 36-38 If...Else...End If statement, 93
data returned by, 56 If...End If block, 227
overview of, 19-20 If...End statement, 67-68
If...Then...ETse block, 106
° G ° If...Then...End If statement, 197
Immediate window (Visual Basic editor)
GetObject () function, 341 overview of, 25-26
getting value of property, 79-80 re-executing statement in, 79
Global icon, 78 running procedure from, 281
global scope and standard module, 13 shortcut keys, 367-369
guessing, 354 testing function in, 281
testing statement in, 42-43
PY H PY viewing, 22
importing
heat of computer, 268 data from external database, 303-305
Help system query from external database, 307-309
Access compared to VBA, 354 standard module, 47-48
argument and, 43-45 table, 303
methods, 112 inserting blank space in code, 157
opening, 39 Insert=>Picture, 196
procedure and, 39-43 Inserte>Procedure, 36, 150
properties and methods, 82-85 instance, 321
showing properties, 75-76 Integer data type, 54, 62
Help window (Object Browser), 33 IsLoaded property of form, 358
hiding Item Data(x) property (combo box
control, 95-96 and list box), 203
toolbar, 21 item, undocking and re-docking, 22

warning message, 125-126
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Kaufeld, John, Access 2003
For Dummies, 9
keyboard shortcuts
Alt+F11 (switch between Access and
Visual Basic editor), 16, 354
Alt+Q (close Visual Basic editor), 15
Code and Immediate window, 367-369
Ctrl+C (Copy), 46
Ctrl+F8 (Run to Cursor), 283
Ctrl+Shift+F8 (Step Out), 283, 284
Ctrl+V (Paste), 46
for debugging, 370
F1 (Help), 39, 356
F2 (open Object Browser), 30
F4 (Properties sheet), 74
F8 (Step Into), 283
Shift+F8 (Step Over), 283
VBA editor, 369
keywords. See also MsgBox () keyword
arguments supported by, 41
Help page for, 39-43, 153-154
Me!, 204
New, 321

o/ o

label, 290
Label Wizard, 159
Levine Young, Margaret, Access 2003
All-in-One Desk Reference
For Dummies, 9
Limit to List property
(combo box), 203
line of code
breaking with continuation character,
156-158
compiling, 28
Linked Table Manager, 298, 299

linking
to external data through code, 305-307
to external tables, 308-309
table, 303
linking lists
across forms, 223-224
getting forms in sync, 228-229
opening form to enter new record,
226-227
overview of, 217-219
running code when form opens, 219-220
running code when user makes a
choice, 220-223
updating combo box or list box, 224-226
list box
description of, 201-202
field names, listing, 204-206
hidden values in, 229-233
linking lists, 217-219
linking lists across forms, 223-229
properties, 203
table/query field values, listing, 213-217
text options, listing, 207-213
unbound control, adding to, 202-203
updating, 224-226, 361
List Rows property (combo box), 203
list separator, 274-275
List Width property (combo box), 203
listing built-in functions, 242
listings
building list of report names, 194
combo box of table and query names,
210-211
combo box of table names, 209-210
combo box value list property,
filling, 208
combo box with form names, filling, 212
copying form data to Excel
worksheet, 339
copying recordset to Excel worksheet,
344-345
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listings (continued)
distinguishing between left and right
mouse clicks, 199

ol o

macro

Form_Address Book Form, 111
Form_Current() procedure, 98
importing query from external
database, 307-308
linking to external table, 309
merge code, 330-331
NumWord() function, 253-255
PaymentMethod_AfterUpdate()
procedure, 94
PCase() function, 248
Send button procedure, 323
SkipLabels procedure, 162-164
updating combo box from table, 222
updating combo box of report
names, 221
updating control on separate form,
228-229
literal string, 83, 157-158
Load Event form event, 98
local scope and class module, 13

actions for, 313-315

description of, 10

Excel, running from Access, 347-348
exporting with, 311-313

macro conversion, 288-289
mailing labels, skipping over used

(SkiplLabels procedure)
calling procedure from event, 170-172
combo box, creating for, 189-195
controls, adding to dialog box, 186-188
copying label report, 165
declaring variables, 165
getting report record source, 165-166
listing, 162-164
overview of, 158-161
passing data to, 164
recordset, creating and filling, 166-170
spin box control, creating for, 195-198
table for storing dialog box settings for,
183-184

local table, 299, 300
Locals window, 282-283
locking control, 96
LockType argument (recordset), 143
logical error
description of, 270, 276-277
slowing down code, 280-284
variables, checking with Debug.Print
expression, 277-280

maintenance mode technology, 142

Make-Table query, 122, 128-129

managing recordset, 144-145

MDB file, 297

Me! keyword, 204

member of class, definition of, 31, 76

Members list (Object Browser), 31

menu. See drop-down menu

message box. See also MsgBox () keyword

logical operators, 67 as application modal, 178

Long data type, 54, 62 code execution and, 177

loop default buttons for, 178-179
description of, 62 designing, 177-180

Do...Loop block, 62-63 Help button, 180
For...Next block, 64-65 overview of, 175

While...Wend block, 64 as pop-up, 178
looping through collections question asking, 176-177
For Each...Next loop, 149-151, responding to button click, 180-182
153, 191 Select Case block and, 182

object, using shorter name for, 152-153 message, custom, showing, 361-362
overview of, 147-148

low-level machine language, 268
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method
Beep of DoCmd object, 81-82
Close of DoCmd object, 109
CopyFromRecordset (Excel), 344
description of, 75-77
DoCmd object for forms, 111-113,
364-365
Help page and, 112
OpenForm of DoCmd object, 82, 107-108,
357-358
Requery, 224-226
TransferDatabase of DoCmd object,
304-307
using, 81-82
Method icon, 77
Microsoft. See also Microsoft Access;
Microsoft Excel; Microsoft Word
ActiveX Data Objects 2.1 Library, 32, 141
DAO 3.6 Object Library, 32
maintenance mode technology, 142
Outlook, sending e-mail via, 322-326
Web site, 354
Microsoft Access
class module, 12-15
client-server relationship and, 297-303
database window, 10
description of, 1
11.0 Object Library, 31
Help system, 354
learning before using VBA, 351
Modules container, 10
Query menu, 122
references for learning about, 9
standard module, 12-13
switching between Visual Basic editor
and, 15-16
Microsoft Excel
code to copy form data to worksheet,
338-347
interacting with, 336
macro, running from Access, 347-348
query and form, creating, 337-338
worksheet, creating, 336-337

Microsoft Word
form, creating, 329-330
merge code, writing, 330-335
sending data to, 326
template, creating, 327-328
Mid () function, 278, 280
modifying existing code
argument list and, 57
copying and pasting from Web, 46-47
For Each...Next loop and, 153
importing standard module, 47-48
overview of, 46, 48, 153-154
SQL statement into VBA code, 123-125
module. See also class module (Access);
standard module (Access)
declarations area, 60
definition of, 89
Module icon, 78
module-level declaration, 36, 60-61
Modules button (Access), 13
Modules container (Access), 10
MOMSecure.mdb example, 300-303
moving editor window, 282
MsgBox () keyword
arguments for, 43-45
buttons argument, 43-44, 177-179
Help page, 40-43
overview of, 38-39
question asking, 176-177
responding to button click, 180-182
syntax for, 176, 272
multidimensional array, 60
multiplication operator (*), 106

o\ o

name, correcting case of with PCase()
function, 248-252
Name property
combo box and list box, 203
of object, 152
of recordset, 145-146

Index 38 ’
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named argument, 45
naming
bang character (!) and, 359
cell or range in Excel, 336
control on form, 203
square brackets and, 91
variable, 61-62
New Customer form example,
223-226, 228
New keyword, 321
NOT operator, 67
numbers
ASCIL, 191
for buttons argument of MsgBox ()
keyword, 178-179
numeric expression, 42
NumWord () function
code for, 253-255
explanation of, 258-265
uses of, 255-257
writing and checking for logical errors,
279-280

o() o

object
for code, choosing, 92-95
as collection, 148
collection compared to, 72-74
color, changing, 99-103
description of, 71
exposing, 28-29
font or style of text, controlling, 103
methods of, 81-82
Name property, 152
referring to, 155-156
special effects, changing, 103-104
using shorter name for, 152
With...End With statement, using to
change appearance of, 104-105
Object Browser tool (Visual Basic editor)
DoCmd object information in, 365
Help methods in, 84-85

help with objects and collections from,
76-77
icons for items in, 77-78
methods listed in, 112-113
object model, exploring through, 319
overview of, 30-33, 355-356
Object data type, 54
object library
accessing, 317-319
description of, 28-29
list of, 31-32
Outlook, 325
referencing external, 321-322
searching, 32-33
setting reference to, 29-30
Object Library icon, 78
object model
ADO (ActiveX Data Objects), 141
description of, 71, 72
exploring, 319
icons for items in, 77-78
objects and collections, 72-74
properties and methods, 75-77
viewing, 74
object variable, declaring, 152
object-oriented, definition of, 10
OLE Automation object library, 32
On Change event, 89
On Click event
description of, 87, 89
PrintBttn control, 188
right-click, detecting, 198-199
On Close form event, 98
On Current form event, 98
On Error statement, 288, 291
On Insert event, 226
On Load event
description of, 190
Form_Load() procedure, 219
use of, 208
On Mouse Down event, 89, 198
one-dimensional array, 59
opacity of background or border, 101
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Open method of recordset, 142-143
OpenArgs argument of OpenForm
method of DoCmd object, 108
OpenForm method of DoCmd object, 82,
107-108, 357-358
opening
class module, 14-15
Excel and workbook, 340-341
Expression Builder, 241
form, 107-108
form and adding related record to
another table, 109-111
form from VBA, 357-358
form to enter new record, 226-227
Help page, 39
module, 15
module in VBA editor, 24
Object Browser, 30
program, 321
Properties sheet, 73-74
Query Properties sheet, 214
operators
comparison, 66-67
logical, 67
Option Compare Database
declaration, 243
OR operator, 67
Orders form example, 223-226, 228
Outlook (Microsoft), sending e-mail via,
322-326
QutputTo action, 311-313, 314

opPoe

page, description of, 10
pane
sizing, 23
undocking or re-docking, 22
parameters, 161
parentheses [()]
checking, 275-276
for ending procedure, 37, 42, 353

passing data
to function, 244-245
to procedure, 55-57
to SkiplLabels procedure, 164
PaymentMethod_AfterUpdate()
procedure listing, 94
PCase() function
code for, 247-248
explanation of, 249-250
uses of, 250-252
writing and checking for logical errors,
277-279
pipe (1), 63
placeholder, 41, 45. See also bookmark
plus sign (+), 44, 106, 157
pop-up message box, 178
positioning cursor, 38, 91-92
pound (#) character, 83
Print Preview, using, 170, 257
printing check amount (NumWord ()
function)
code for, 253-255
explanation of, 258-265
uses of, 255-257
writing and checking for logical errors,
279-280
printing report, 363-364
Private procedure, 19, 20
procedure. See also function;
SkipLabels procedure;
Sub procedure
calling, 18
calling from event, 170-172
class type, working with, 87-89
creating, 36-38
decision-making and, 128
definition of, 17
Form_Current(), 97-98
Form_Load(), 219
Function, 19-20, 36-38, 56
parentheses for ending, 37, 42, 353
passing data to, 55-57
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procedure (continued)
PaymentMethod_AfterUpdate()
listing, 94
Private, 19, 20
Public, 19, 37
running from Immediate window, 281
saving, 95
Send button, 323
Sub, 18-19, 20
tying to event, 17
procedure-level declaration, 61
program, opening, 321
programming language
description of, 11
high-level, 268-269
Project Explorer window (Visual Basic
editor), 23-24, 25
Project icon, 78
Project/Library list (Object Browser),
31-32
Properties sheet
All tab, 185, 203
Data tab, 189
Events tab, 88, 96
Format tab, 99
viewing, 73-74

Properties window (Visual Basic editor),

24-25
property
BackColor, 100
BackStyle, 101
BOF, 145
BorderColor, 100
BorderStyle, 101
Bound Column, 230, 232-233
Column Count, 232
of control, referring to, 359
Count property of collection, 79,
147-148
Default Value, 203
description of, 75-77
EOF, 145
ForeColor, 100, 103
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IsLoaded property of form, 358
Item Data(x), 203
Limit to List, 203
List Rows, 203
List Width, 203
Name, 145-146, 152, 203
on open form, referring to, 359
Row Source, 201, 203, 205
Row Source Type, 203
Special Effects, 103-104
Unique Records, 214
Unique Values, 214
Value, 145-146, 203
value of, changing, 80
value of, getting, 79-80
Visible property of control, 79-80,
95-96
Property icon, 77
Public function, 19, 37

o () o

-
QBE (Query-by-Example) grid, 119, 120,
121, 133-134
query
in Access compared to in VBA, 120
action, 121-123, 125-126, 136
append, 122, 131-132
to append record to table, 133-134
Customer Lookup, 230-231, 234
Datasheet view of, 138
Delete, 122, 134-137
description of, 10
importing from external database,
307-309
Make-Table, 122, 128-129
select, 117-118, 121-123, 126, 137-140
as SQL statement, 117-118, 120-121
Unique Cities, 237-238
Update, 122, 123, 134-136
viewing SQL view of, 213
Query Design, 123
Query menu (Access), 122
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query names, making list of, 210
Query Properties sheet, 214
Query=>Append Query, 131, 133
Query-by-Example grid. See QBE grid
Query=>Run, 123, 252
Query=>Update Query, 251

question, asking of user, 362-363
question mark (?), 79

quick find tool, combo box as, 233-236
Quick Info tip, 38, 39, 84

quotation marks ("), 58, 83, 353

o R o

read-only control, 96
record. See also recordset
action query on one, 136
appending to table, 131-134
changing or deleting, 134-136
opening form to enter new, 226-227
requerying control with every new,
238-239
recording macro, 347-348
recordset
closing, 146
connection, defining, 140-141
copying to Excel worksheet, 344-347
creating from external table, 309-310
defining, 141
filling with data, 142-143
managing, 144-145
as object, 140
referring to fields in, 145-146
select query and, 126, 137-140
SkipLabels procedure, 166-170
of table, creating, 303
re-docking item, 22
re-executing statement in Inmediate
window, 79
reference, setting to object library, 29-30
References dialog box, 29-30
referencing external object library,
321-322

referring
to field in recordset, 145-146
to field name, 154-155
to object, 155-156
to open form, 358-359
to worksheet cell from VBA, 341-343
report
class module, opening, 14-15
creating, 159
description of, 10
printing, 363-364
for printing checks, 256-257
report names, making list of, 211-213
Requery method, 224-226
requerying control with every new
record, 238-239
responding to form event, 96-99
Restore Window button
(Code window), 27
Resume statement, 288
returning value
custom procedure and, 56
from function, 245
RGB values, 100-101
right-click, detecting, 198-199
Row Source property
combo box and list box, 201, 203
Field List combo box, 205
Row Source Type property (combo box
and list box), 203
running
action query, 122-123
Excel macro from Access, 347-348
running code
when form opens, 219-220
when user makes a choice, 220-223
runtime, 269
runtime error
description of, 270-271, 285-286
error handler, writing, 290-294
responding to, 286-287
trapping, 287-290

Index 385
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SalesTax() function example, 244-247
saving
document as Word template, 327-328
procedure, 95
scope, 60
Screen.ActiveControl, 155
Search box (Object Browser), 31
Search Results pane (Object Browser), 33
searching object library, 32-33
Select Case block
decision-making and, 68-69
message box buttons and, 182
select query
example of, 117-118
overview of, 121
recordset and, 126, 137-140
selecting code to copy, 46
self-referential combo box, creating,
237-239
Send button procedure, 323
sending e-mail via Outlook, 322-326
SendObject action, 314
server, definition of, 297
setting
breakpoint in code, 280-284
reference to object library, 29-30
Shift+F8 (Step Over), 283
shortcut keys
Alt+F11 (switch between Access and
Visual Basic editor), 16, 354
Alt+Q (close Visual Basic editor), 15
Code and Immediate window, 367-369
Ctrl+C (Copy), 46
Ctrl+F8 (Run to Cursor), 283
Ctrl+Shift+F8 (Step Out), 283, 284
Ctrl+V (Paste), 46
for debugging, 370
F1 (Help), 39, 356
F2 (open Object Browser), 30
F4 (Properties sheet), 74

F8 (Step Into), 283
Shift+F8 (Step Over), 283
VBA editor, 369
showing
control, 95-96
custom message, 361-362
Immediate window, 25
properties, 75-76
toolbar, 21
Simpson, Alan, Access 2003 All-in-One
Desk Reference For Dummies, 9
Single data type, 54, 62
sizing
editor window, 282
pane, 23
skills, as learned, 356
SkipLabels procedure
calling procedure from event, 170-172
combo box, creating for, 189-195
controls, adding to dialog box, 186-188
copying label report, 165
declaring variables, 165
getting report record source, 165-166
listing, 162-164
overview of, 159-161
passing data to, 164
recordset, creating and filling, 166-170
spin box control, creating for, 195-198
table for storing dialog box settings for,
183-184
skipping over used mailing labels. See
SkiplLabels procedure
slowing down code, 280-284
source code, 269, 270
Special Effects property, 103-104
spin box control, creating, 195-198
Split bar (Object Browser), 31
splitting database into two files, 297-303
SQL INSERT INTO statement, 132-133
SQL (Structured Query Language)
Access query and, 120-121
getting into VBA, 123-125
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overview of, 117-118
statement syntax, 118-119
storing statement in variable, 126-128
SQL View, 118, 123
square brackets ([])
in Access, 91
as representing argument, 40, 41
as representing name, 154-155
typing, 353
stacking editor windows, 282
standard module (Access)
creating, 35-36
custom function and, 243
importing, 47-48
overview of, 12-13
standard OLE Automation object library
(stdole), 32
statement
CREATE TABLE (SQL), 129-130
Debug.Print, 150, 277-280
definition of, 17
Dim, 152
DoCmd.RunSQL, 124, 125, 146
If...Else...End If,93
If...End, 67-68
If...Then...End If, 197
On Error, 288, 291
order of arguments in, 45
re-executing in Immediate window, 79
Resume, 288
SQL INSERT INTO, 132-133
SQL, storing in variable, 126-128
With...End With, 104-105
stdole (standard OLE Automation object
library), 32
step mode, 281, 283-284
storing
dialog box settings, 183-184
SQL statement in variable, 126-128
storing data
in arrays, 58-60
in combo box, 232-233

lifetime of variable and, 60-61
in variables and constants, 57-58
StrConv () function, 247, 249
string
concatenating, 157
literal, 83, 157-158
Value List, 207-203
String data type, 54, 62
string expression, 42
string variable, creating, 58
Structured Query Language. See SQL
style of text, changing, 103
Sub procedure
arguments and, 56
creating, 36-38
overview of, 18-19, 20
testing, 150-151
testing from Immediate window, 281
switching between Access and Visual
Basic editor, 15-16
syntax. See also code; listings
ADO recordset, creating, 142-143
for argument, 55
assigning object to object variable, 152
for built-in functions, accessing, 242
calling custom VBA function from
event, 172
calling procedure from event, 171
color of property, changing, 100
CREATE TABLE statement (SQL), 129-130
declaring object variable, 321
definition of, 31, 38-39
Do...Loop block, 63
enabling or disabling control, 90
focus, setting to control, 92
Help page and, 40
identifier, 81
If...End statement, 67
importance of, 78-79, 351-352
MsgBox () keyword, 176, 272
OpenForm method of DoCmd object, 82
opening program, 321
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syntax (continued)
punctuation marks in, 353
quotation marks (") in, 83
recordset, creating, 138-139
for referring to object property, 75, 79
Requery method, 224
running macro in open workbook, 348
Select Case block, 68
SQL INSERT INTO statement, 132-133
SQL statement, 118-119
Visible property of control, 80
system modal, 178
system table, 209

oJ e

table. See also recordset
action query and, 121
action query on one record, 136
adding related record to another,
109-111
appending record to, 131-133
closing and deleting through VBA,
130-131
creating recordset from external,
309-310
description of, 10
linked, converting to local, 300
linking to external, 308-309
making list of names of, 208-211
new, creating from existing, 128-129
new, empty, creating from VBA, 129-130
record, changing or deleting, 134-136
select query and, 121
for storing dialog box settings, 183-184
Table/Query field values, listing, 213-217
tag, 61-62
taskbar button, 15, 16
testing
on copy of data, 251
expression in Immediate window,
26, 42-43
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function, 246-247
function from Immediate window, 281
macro, 312, 348
Print Preview, using, 170
Sub procedure, 150-151
Sub procedure from Immediate
window, 281
while writing code, 277-280
text
font or style of, controlling, 103
literal, 83, 157-158
text options, listing
form or report names, 211-213
table and query names, 208-211
overview of, 207-208
title argument, 44
Toggle Folders button (Project Explorer
window), 23
Togglew>Breakpoint, 281, 284
toolbar
Debug, 284
Project Explorer, 23
Tools=>Database Utilitiesz>Database
Utilities, 299
Tools=>Database Utilities>Linked Table
Manager, 298
Tools>Macro~Convert Macros to Visual
Basic, 313
ToolseoMacro=>Macros, 348
Tools>Macro>Record New Macro, 347
Tools=>References, 29, 318
TransferDatabase action, 314
TransferDatabase method of DoCmd
object, 304-307
TransferSpreadsheet action, 314
TransferText action, 314
transparency of background or
border, 101
trapping runtime error, 287-290
two-dimensional array, 59-60
typing code, 27-28
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UCase() function, 278
unbound control, adding to form,
187, 202-203
undocking
Code window, 27
item, 22
Unique Cities query, 237-238
Unique Records property, 214
Unique Values property, 214
unlocking control, 96
Update query, 122, 123, 134-136
updating
combo box from table, 222
combo box of report names, 221
combo box or list box, 224-226, 361
control on separate form, 228-229
user, asking question of, 362-363
User Defined Type icon, 78

o[/ e

value
for argument, 42
declaring and assigning, 60
function and, 242
hidden, in combo box and list box,
229-233
parameters and, 161
of property, getting and changing,
79-80
returned by MsgBox () keyword
buttons, 180
returning, 56
returning from function, 245
RGB, 100-101
Value List string, 207-213
Value property
combo box and list box, 203
recordset, 145-146

variable
checking with Debug.Print
expression, 277-280
declaring, 165
lifetime of, 60-61
naming conventions for, 61-62
storing color in, 102
storing data in, 57-58
storing SQL statement in, 126-128
Variant data type, 54, 62
VBA editor. See Visual Basic editor
VBA Keyword or data icon, 78
VBA (Visual Basic for Applications)
Access and, 1
consistency of language, 1, 9
description of, 9, 11-12
Help system, 354
learning Access before using, 351
object library, 32
View argument of OpenForm method of
DoCmd object, 107
View Code button (Project Explorer
window), 24
View Object button (Project Explorer
window), 24
View=>Immediate Window, 22
viewing
existing code, 153-154
form events, 96-97
object model, 72, 74
Properties sheet, 73-74
SQL view of query, 213
Vieww>Locals Window, 282
View>Object Browser, 30
View=>Properties, 74
View=>Toolbars, 21
Visible property of control, 79-80,
95-96
Visual Basic editor. See also Code
window; Immediate window; Object
Browser tool
closing, 15-16
description of, 15
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Visual Basic editor (continued) what-if scenario, 336
item, undocking and re-docking, 22 WhereCondition argument of OpenForm
moving and sizing windows in, 282 method of DoCmd object, 108
Project Explorer window, 23-24, 25 WhiTe...Wend block, 64
Properties window, 24-25 WindowMode argument of OpenForm
shortcut keys, 369 method of DoCmd object, 108
sizing pane, 23 With...End With statement, 104-105
toolbar, hiding or showing, 21 Word (Microsoft)
View menu, 22 form, creating, 329-330

Visual Basic for Applications. See VBA merge code, writing, 330-335

sending data to, 326

PY w P template, creating, 327-328

warning message, hiding, 125-126 Y X’ Y

Web sites
for book, 5 XOR operator, 67

Help file, custom, creating, 180
Microsoft, 354



